Creating Maps in ArcMap: A Quick Guide

1. Before You Begin ........................................................................................................................................... 2
2. Obtaining Geospatial Data ........................................................................................................................... 2
   Obtaining Geospatial Data Online .............................................................................................................. 2
3. Open ArcMap and Add Data to your Map .................................................................................................... 2
4. Explore the Data ............................................................................................................................................. 5
   Panning and Zooming Around the Map ........................................................................................................ 5
   Open the Attribute Table ............................................................................................................................ 5
   Identify Features ........................................................................................................................................ 6
5. Change the Appearance of Layers .................................................................................................................. 8
   Symbolising Features by Single Symbol ...................................................................................................... 9
   Changing Symbols for Lines ......................................................................................................................... 9
   Choosing Symbology for Points .................................................................................................................... 10
   Choosing Symbology for Polygons ............................................................................................................... 11
   Symbolising Features by Unique Values ....................................................................................................... 12
   Applying Transparency to Layers ............................................................................................................. 15
6. Add Labels .................................................................................................................................................... 17
7. Add Text and Graphics (Optional) .................................................................................................................. 20
   Placing Graphics ........................................................................................................................................ 21
   Placing Text ............................................................................................................................................... 22
   Modifying Graphics .................................................................................................................................. 22
   Selecting Graphics ..................................................................................................................................... 22
   Resizing and Moving Graphics .................................................................................................................... 22
   Rotating Graphics ....................................................................................................................................... 23
   Changing Size, Colour, and Style of Graphics ............................................................................................. 23
   Modifying Text ........................................................................................................................................... 23
   Selecting Text Objects ............................................................................................................................... 23
   Moving Text Objects ................................................................................................................................. 23
   Resizing Text Objects .............................................................................................................................. 23
   Rotating Text Objects ................................................................................................................................ 23
   Changing Properties of Text Objects ......................................................................................................... 24
8. Data View and Layout View ........................................................................................................................ 24
9. Format the Page in Layout View (Optional) ................................................................................................ 25
10. Insert Map Elements in Layout View ......................................................................................................... 26
    Add a Legend ............................................................................................................................................. 27
    Add a North Arrow ................................................................................................................................... 32
    Add a Scale Bar ......................................................................................................................................... 33
11. Save, Export, and/or Print Your Map ......................................................................................................... 42
    Exporting Maps for Print or Web Use ....................................................................................................... 42
    Printing Your Map ................................................................................................................................... 43
    Exporting your Map to KML for use in Google Maps or Google Earth .................................................... 44

Appendix A: Projecting Your Data ................................................................................................................ 45

Creating Maps in ArcMap: A Quick Guide 1
1. Before You Begin

Before you start making a map, ask yourself the following questions:

- What is it that I want to map?
- Is a map necessary and appropriate for my purposes, or will a chart, graph, or table suffice?
- What is my geographical ‘area of interest’? That is, which area(s) of the world will I map?

Once you have answered these questions, move on to the next step.

2. Obtaining Geospatial Data

The University Map Library lists all of its geospatial data holdings on its website: 
http://www.lib.uwaterloo.ca/locations/umd/geospatial_data.html. Data holdings are organized by level of geography: browse through the various datasets available for your chosen area of interest.

Make a note of the data you feel might be relevant to your research interests and/or might be useful to include on a map.

Bring this list into the Map Library during reference hours (see this link for current hours). Map Library staff will assist you in obtaining the desired data. You will be requested to read and sign a data release agreement before the data can be released to you.

You may either use the data on one of three GIS workstations in the Map Library or take the data away with you. If you opt for the latter, please remember to bring a USB key or blank CD or DVD with you!

Obtaining Geospatial Data Online

You may be able to locate the data you need on the internet (the Map Library website, above, has some links to some online data repositories). This data may be in one of a variety of formats.

If you run into trouble with the format of this data, search ESRI Desktop Help (see the link below) for the extension of the problematic file – the Help file will tell you how to convert your data to a usable format.

3. Open ArcMap and Add Data to your Map

Before continuing with this tutorial, take a moment to read through Mapping and visualisation in ArcMap, from ESRI’s ArcGIS Desktop Help file, for a brief introduction to ArcMap: http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Mapping_and_visualization_in_ArcMap.
Once you are familiar with the purpose and capabilities of ArcMap, you are ready to begin. Open ArcMap by navigating to \textit{Start} -> \textit{Programs} -> \textit{ArcGIS} -> \textit{ArcMap}.

By default, a start-up splash window will appear once ArcMap has loaded:

![ArcMap start-up window]

Ensure ‘A new empty map’ is selected, and click ‘OK.’

A new dialogue box will open, prompting you to add data to the map. Browse to the location of the geospatial data you obtained from the Map Library:

![Add Data dialogue box]

Select the Shapefile(s) you want to add to the map. Use the \textit{Shift} or \textit{Control} keys to select multiple Shapefiles. Click ‘Add’ to add them to ArcMap.
**Note:** While the start-up splash screen and Add Data dialogue box are usually displayed automatically, this feature may have been disabled. If, upon opening ArcMap or clicking ‘OK’ in the start-up splash screen, you are presented with a blank screen, simply click the Add Data button ( ) to open the Add Data dialogue box.

The Shapefiles you selected will now be shown in ArcMap’s Table of Contents and drawn in the Data View window:

Note that ArcMap applies a random colour to each new layer: the colours are not necessarily meaningful or appropriate.
4. Explore the Data

Now that you have added your data to ArcMap, take a moment to familiarise yourself with it.

**Panning and Zooming Around the Map**

First, use the standard Tools toolbar to zoom and pan around the data:

- Zoom In
- Zoom Out
- Zoom In by a Fixed Amount
- Zoom Out by a Fixed Amount
- Pan
- Zoom to the Full Extent of the Data
- Return to the Previous Zoom Level
- Return to the Next Zoom Level

Experiment with the different tools indicated above – you will quickly learn what each tool is for.

**Open the Attribute Table**

Every Shapefile or other geospatial dataset has an associated attribute table, which contains important information about each feature such as an identification number, a name, or a description. Take a moment to look through the attribute table of each Shapefile on your map, to get a sense of what kinds of information they contain.

To open an attribute table, right-click on a layer in the Table of Contents, and click ‘Open Attribute Table’:
Look at the field names in the attribute table which opens. The example below is the attribute table of the Streets dataset for the City of Waterloo:

It may take some guesswork to determine what each of the field names mean.

Once you are familiar with the field names, close the attribute table by clicking the [x] in the upper-right-hand corner (circled in blue above). Be careful not to close ArcMap itself!

**Identify Features**

Now that you are familiar with the field names and the type of information the Shapefile contains for each feature, try identifying a few individual features to see information about them specifically.

First, zoom in to a small area on your map using the ‘Zoom In’ tool:

Now, switch to the ‘Identify’ tool:

The Identify window will open. Drag it out of the way, if necessary. Click on any feature in your map, and watch what happens to the Identify window.

In the illustration on the following page, the ‘Field’ column contains all of the field names from the attribute table, and the ‘Value’ column contains all of the information for the identified feature.
Try identifying a few more features from different layers. Note that, by using the ‘Identify from’ dropdown box, you can choose which layer you want to query:

Once you are familiar with your data, move on to the next step: changing the appearance of each layer in your map.
5. Change the Appearance of Layers

Recall that ArcMap automatically applies an arbitrary colour and symbol to each newly added layer. This is not always desirable, and you may find you need to change these colours and symbols.

To begin, open the Layer Properties window for one of the layers in your map. To do so, right-click on a layer name in the Table of Contents and click on ‘Properties...’:

Switch to the ‘Symbology’ tab:

Take a moment to look through the various options on the left. This tutorial will explain how to show features by Single Symbol and Unique Values. For more advanced symbology options, see the “Mapping Census Data” tutorial, available from the University Map Library.
Symbolising Features by Single Symbol

As may be apparent, symbolising features by a single symbol means that every feature in the selected layer will be drawn using the same colour, symbol, and size.

To change the single symbol by which features will be drawn, open the Layer Properties window and switch to the Symbology tab. Click the large button indicated below:

![Layer Properties window](image)

Note that this button may appear differently depending on whether the selected layer is a point, a line, or a polygon. The following pages explain how to change single symbols for each of these three geography types.

Changing Symbols for Lines

After pressing the button indicated above, the Symbol Selector window will open. From here, you can choose one of the preset symbols at left, then change the colour and/or line width as desired, as illustrated on the following page.
Choosing Symbology for Points

The process for changing the symbology of points is slightly different from that for lines. First, choose a preset marker symbol from the list at left in the Symbol Selector. Next, change the colour if necessary. Finally, increase or decrease the size of the marker symbol, and, if desired, set an appropriate rotation angle: all symbols will be rotated by the specified angle on your map. See the following page for an illustration.
Choosing Symbology for Polygons

The process for changing the symbology of polygons is, again, slightly different from that for points and lines. First, if you like, choose a preset polygon style from the list at left in the Symbol Selector. This first step is optional. Next, change the Fill Color, and specify an appropriate Outline Width and Colour as illustrated on the following page.
If you want empty polygons – that is, just an outline – set the Fill Colour to ‘No Colour.’ To disable outlines, set the Outline Width to ‘0’.

Symbolising Features by Unique Values

Whereas symbolising features by single symbol results in every feature having the same size, symbol, and colour, symbolising features by unique values results in different categories of features, each of which can be shown using different symbols.

Before you can symbolise features by unique values, take another look at the attribute table of the layer in question, and decide which field you will use to categorise the features.
For instance, you may wish to symbolise a ‘Roads’ layer by street classes – highways, major arterials, and local roads – and apply different line widths to each. Or you may wish to symbolise a ‘Schools’ layer according to whether the school is elementary, secondary, or post-secondary.

Once you have decided which field name to use to categorise the features, open the Layer Properties window and switch to the Symbology tab.

In the list at the left of the Layer Properties window, select ‘Categories’ and ensure ‘Unique Values’ is selected:

![Layer Properties Window]

From the ‘Value Field’ dropdown box, select the field name which represents the field you will use to categorise the features. In this example, I will use STREETCLAS, which contains a single letter denoting different types of streets:
After choosing the appropriate field, click **Add All Values**. All of the unique values contained in the selected field will be shown in the window:

You can now apply different symbols to each category by double-clicking the appropriate symbol swatch, as illustrated above. Refer to the previous section of this tutorial, *Symbolising Features by Single Symbol*, if you need help.

After applying the different symbols, click ‘OK’ or ‘Apply’ to see the changes on the map.

You may find you need to combine different categories – for instance, in the example above, I only want three categories: highways (H), Regional roads (R), and local roads (other categories). To combine categories, hold down the ‘Control’ key and select all of the categories you wish to combine. Right-click one of the *selected* categories and click ‘Group Values’:

![Double-click a swatch to change the symbol](image-url)

**Creating Maps in ArcMap: A Quick Guide**
Once you have applied the different symbols appropriately, set labels for each category. In the Layer Properties window’s Symbology tab, select one category and click once on the label in the center column. Type a descriptive label:

[Diagram of Layer Properties window showing the Symbology tab with a table and options for symbol, value, label, and count]

Repeat these steps until all categories have a label. Click ‘OK’ to exit the Layer Properties window.

**Applying Transparency to Layers**

In some situations, particularly when you have overlapping polygon layers in your map, you may want to adjust transparency levels to allow readers to see both layers at once. Consider the scenario below – two polygon layers, wooded areas and parks, overlap in some areas. Without transparencies (left), it is hard to tell where the wooded areas and parks overlap. With transparencies (right), it is easy:

[Two maps, one with transparent layers showing the overlap clearly, and one without transparencies showing the overlap obscured]
To increase a layer’s transparency, open its Layer Properties window and switch to the ‘Display’ tab:

In the textbox beside ‘Transparent’, enter a value. A setting of ‘0’ will result in a fully opaque layer; a setting of ‘100%’ will result in a fully transparent layer. Experiment with different settings until you find one which works well.
6. Add Labels

Adding labels to your map can make your map more useful, informative, and visually appealing. Adding labels is quite simple in ArcMap.

First, determine which layers you want to add labels for. Be careful not to overdo it – only add labels to layers that need them!

For each layer to be labelled, determine which field in its attribute table contains the text to use as a label.

Now, open the Layer Properties window for one of the layers to be labelled. Switch to the ‘Labels’ tab:

![Layer Properties window for adding labels](image)

From the ‘Label Field’ dropdown box, choose the field which contains the text to use as a label:

![Dropdown box for choosing label field](image)

Click ‘Apply’ to see the labels on your map.
You will probably want to change the font, size, and colour of the labels. Do so using the options illustrated below:

To ensure your labels show up clearly, try applying a ‘halo’ to the labels. The images below illustrate the effect of this ‘halo’ – the label on the left has none, and the label on the right has a mask applied.

To apply a halo, click the ‘Symbol’ button next to the font settings illustrated above.

In the Symbol Selector window which opens, click ‘Properties’ and switch to the ‘Mask’ tab:

Switch the radio button to ‘Halo’ and, using the preview in the left of the window, increase or decrease the ‘Size’ as appropriate:

If necessary, you can change the colour of the halo by clicking the ‘Symbol’ button pictured above and using the colour palette to select a different colour.

Once you are satisfied with the halo, click ‘OK’ twice to return to the Layer Properties window.

Continue to experiment with different font sizes and colours until you are happy with the labels on your map. See the following page for some examples of different label styles.
7. Add Text and Graphics (Optional)

You may wish to supplement the labels on your map with additional, manually-inserted text and/or graphics. For example, I wish to add a label for the Uptown Waterloo Business Improvement Area on a map of Uptown Waterloo. However, as shown in the attribute table for this dataset below, there are no fields which might be used for labelling:

Instead, I will add text to the map to ‘simulate’ a label.

To add text or graphics to your map, open the Drawing toolbar if it is not already open. To do so, right-click on any toolbar in ArcMap to open a list of available toolbars:

Click ‘Draw’ to turn on the Drawing Toolbar.

Using the Drawing toolbar, you can easily add and format text and graphics.
Open the drop-down boxes for graphics and text, indicated above. Browse through the examples below, and decide what type of text or graphic you want to insert.

### Placing Graphics

<table>
<thead>
<tr>
<th>Name</th>
<th>Tool</th>
<th>Example</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Square or Rectangle</td>
<td>![Square or Rectangle Icon]</td>
<td><img src="image" alt="Square or Rectangle Example" /></td>
<td>Click and hold the left mouse button where one corner of the square or rectangle will be. Drag your mouse to set the size of the shape. Hold down ‘Shift’ while doing so to create a true square. Release the mouse button to finish the shape.</td>
</tr>
<tr>
<td>Polygon</td>
<td>![Polygon Icon]</td>
<td><img src="image" alt="Polygon Example" /></td>
<td>Click and release the left mouse button at each vertex (that is, corner) of the new polygon. Double-click when placing the last vertex to finish the shape.</td>
</tr>
<tr>
<td>Circle</td>
<td>![Circle Icon]</td>
<td><img src="image" alt="Circle Example" /></td>
<td>Click and hold the left mouse button where the center of the circle will be. Drag your mouse to set the size of the shape. Release the mouse button to finish the shape.</td>
</tr>
<tr>
<td>Ellipse</td>
<td>![Ellipse Icon]</td>
<td><img src="image" alt="Ellipse Example" /></td>
<td>When drawing an oval, you must actually draw the rectangle which contains the oval. Click and hold the left mouse button at one corner of this rectangle, and drag it to set the size. Release the mouse button to finish the shape.</td>
</tr>
<tr>
<td>Line</td>
<td>![Line Icon]</td>
<td><img src="image" alt="Line Example" /></td>
<td>Click and release the left mouse button at each vertex (that is, corner) of the new line. Double-click when placing the last vertex to finish the line.</td>
</tr>
<tr>
<td>Bezier Curve</td>
<td>![Bezier Curve Icon]</td>
<td><img src="image" alt="Bezier Curve Example" /></td>
<td>Click once to create the first vertex of the Bezier curve. Click again to create the second vertex. Place the next vertex such that the correct curve is created. Continue as necessary. Double-click to finish the line.</td>
</tr>
<tr>
<td>Freehand Line</td>
<td>![Freehand Line Icon]</td>
<td><img src="image" alt="Freehand Line Example" /></td>
<td>Click and hold the left mouse button to start the line. While holding the button, drag your mouse to draw the line. Release the mouse button to finish the line.</td>
</tr>
<tr>
<td>Point Marker</td>
<td>![Point Marker Icon]</td>
<td><img src="image" alt="Point Marker Example" /></td>
<td>Click once to place the point.</td>
</tr>
</tbody>
</table>
**Placing Text**

<table>
<thead>
<tr>
<th>Name</th>
<th>Tool</th>
<th>Example</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Text</td>
<td>![Image]</td>
<td>![Plain Text]</td>
<td>Click once; type in text. Press ‘Enter’ when finished. Move text to desired location. Follow steps under ‘Modifying Text’ to change font.</td>
</tr>
<tr>
<td>Splined Text</td>
<td>![Image]</td>
<td>![Splined Text]</td>
<td>Use the left mouse button to draw a path that the text will follow – click once at each vertex. Double-click to finish this path, then type in the text. Press ‘Enter’ when finished. Follow steps under ‘Modifying Text’ to change font.</td>
</tr>
<tr>
<td>Callout</td>
<td>![Image]</td>
<td>![Callout]</td>
<td>Click once where the point of the callout box will go. Type in text. Press ‘Enter’ when finished. Move the callout rectangle; the point of the arrow will remain anchored where you clicked. Follow steps under ‘Modifying Text’ to change font.</td>
</tr>
<tr>
<td>Polygon Text</td>
<td>![Image]</td>
<td>![Text Within Polygon]</td>
<td>Use the left mouse button to draw a polygon by clicking once at each vertex. Double-click to finish this polygon. Double-click the finished polygon then type in the text in the window which opens. Press ‘OK’ when finished. Follow steps under ‘Modifying Text’ to change font.</td>
</tr>
<tr>
<td>Rectangle Text</td>
<td>![Image]</td>
<td>![Text in a Rectangle]</td>
<td>Use the left mouse button to draw a rectangle: click once and hold at one corner of the rectangle then drag the mouse to set the size of the rectangle. Release the mouse button. Double-click the finished rectangle. Type in the text in the window which opens and press ‘OK’ when finished. Follow steps under ‘Modifying Text’ to change font.</td>
</tr>
<tr>
<td>Circle Text</td>
<td>![Image]</td>
<td>![Text in a Circle]</td>
<td>Use the left mouse button to draw a rectangle: click once and hold at the center of the new circle and drag the mouse to set the size of the circle. Release the mouse button. Double-click the finished circle. Type in the text in the window which opens and press ‘OK’ when finished. Follow steps under ‘Modifying Text’ to change font.</td>
</tr>
</tbody>
</table>

**Modifying Graphics**

**Selecting Graphics**

Use the black ‘Select Elements’ arrow in the Drawing Toolbar to select the graphic to modify:

![Select Elements](image)

**Resizing and Moving Graphics**

You can use the ‘Select Elements’ arrow to resize the graphic by using the control points around the graphic. You can also move graphics by clicking them, holding down the mouse button, and dragging them.
Rotating Graphics

To rotate graphics, select a graphic using the ‘Select Elements’ tool, then use the ‘Rotate’ tool in the graphics toolbar to rotate the graphic. Click once and hold down the mouse button while dragging your mouse to rotate it – this takes some experimentation to get the angle correct.

Changing Size, Colour, and Style of Graphics

Using the ‘Select Elements’ tool, select a graphic, right-click the selected graphic and click ‘Properties...’

If the graphic is a polygon, change the fill colour, outline colour, and outline widths as necessary.

If the graphic is a line, change the line width and colour as necessary. Click ‘Change Symbol’ for more options and preset line styles.

If the graphic is a point, change the point size and colour as necessary. Click ‘Change Symbol’ for more options and preset point markers.

Modifying Text

Selecting Text Objects

Use the black ‘Select Elements’ arrow in the Drawing Toolbar to select the text object to modify: Note: You cannot select or modify labels using this tool.

Moving Text Objects

Use the ‘Select Elements’ arrow to select the text object, and then click on the selected object and drag your mouse while holding down the left mouse button to move it.

Resizing Text Objects

You can only resize text containers – that is, the rectangle, polygon, or circle created when using the Rectangle Text, Polygon Text, or Circle Text tool – you cannot resize the text itself (except by increasing or decreasing the font size). To resize text containers, select the text object using the ‘Select Elements’ arrow and use the control handles around the object’s periphery to resize the object.

Rotating Text Objects

To rotate text objects, select the object using the ‘Select Elements’ arrow, then switch to the ‘Rotate’ tool. Click once near the selected object, and hold down the mouse button while dragging your mouse to rotate the object.
Changing Properties of Text Objects

To change the font, colour, and other properties of a text object, select the object with the ‘Select Elements’ arrow. Double-click the selected object OR right-click and click ‘Properties...’ to open the Properties window.

Click ‘Change Symbol’ to change the various properties of the text. See the section on Adding Labels in this tutorial for further instructions on changing text properties.

8. Data View and Layout View

ArcMap provides two ways to view a map:

- Data view
- Layout view

Each view lets you look at and interact with the map in a specific way.

When you want to browse the geographic data on your map, choose data view. Data view is an all-purpose view for exploring, displaying, and querying the data on your map. This view hides all the map elements on the layout, such as titles, north arrows, and scale bars, and lets you focus on the data in a single data frame, for instance, editing or analysis.

When you're preparing your map's layout, you'll want to work with it in layout view. In layout view, you'll see a virtual page on which you can place and arrange map elements, and you can do almost everything you can in data view, plus design your map (ESRI Desktop Help).

When you've finished adding data, text, labels, and graphics to your map, switch to Layout View to format the map page for printing or export.

To switch between Data View and Layout View, use the buttons in the lower left-hand corner of the map:
After switching to Layout View, take a quick look at the ‘virtual page’ in front of you. By default, it will be a portrait-oriented, letter-size page, with your map centered somewhere in the middle of the page (see example at right).

Before making any alterations to the map layout, it is important to note that the tools used in Layout View and Data View are different.

In Data View, remember, you used the tools pictured below to zoom in and out.

These tools allow you to zoom in and out in the map. The Layout View tools, conversely, allow you to zoom in and out on the page without affecting the zoom level of the map itself.

Open the Layout toolbar by right-clicking anywhere on a toolbar and clicking ‘Layout’. The toolbar is pictured below:

Experiment with the two sets of zoom tools to understand the difference between them.

9. Format the Page in Layout View (Optional)

You may decide that a portrait-oriented, letter-size page is not adequate for your needs – for instance, you might want to set the orientation to Landscape, or you may want to create a small, 4” square map for insertion into a report.

To change the orientation and page size of your map layout, navigate to ‘File -> Page and Print Setup’ (see right).

In the dialogue box which opens, choose a different paper size and/or orientation.

To set a custom page size (for example, 6” x 8”), uncheck the checkbox beside ‘Use Printer Paper Settings’ and type in the diameters of the custom page in the text boxes (see illustration on following page).
Click ‘OK’ to apply your changes to the page layout.

Resize the map to fit the page using the ‘Select Elements’ tool ( ). Select the data frame (i.e., the map) and use the control handles to resize the map.

If necessary, use the Zoom and Pan tools ( ) to zoom in and out in your map so it fits properly within the data frame.

10. Insert Map Elements in Layout View

To complete your map, you should add a few important map elements to the page.

Most of these map elements can be found under the ‘Insert’ menu:
**Add a Legend**

Navigate to the ‘Insert’ menu, and click ‘Legend.’ In the dialogue box which opens, choose which layers to display in the legend, and reorder the layers as appropriate:

In most cases, it is not necessary to include the ‘obvious’ layers, such as water or roads, on a legend. Use your judgment – will your audience be able to understand the meaning of such layers if they are excluded from the legend?

Once you are satisfied with the legend items, click ‘Next >’ to format the title of the legend.

By default, the legend title is “Legend”. If desired, change the legend title and the font and/or justification of the title.

In many cases, a legend title is unnecessary and redundant. Should you decide not to show a legend title, simply leave the settings in this window as-is – you can disable the title at a later stage.

Click ‘Next’ to move on.

If desired, at this stage, you can add a border, background, and/or drop-shadow to your legend.
Simply use the drop-down boxes to apply these settings:

![Legend Wizard](image)

You may wish to increase the ‘Gap’ – leaving it set to 0 will result in your legend border appearing right next to the legend text, with no white space.

Click ‘Next’ to continue.

If you like, you can override the default settings for symbol patches in the legend. Normally, line features are displayed as straight horizontal lines, while polygon features are shown as rectangles. In most cases, the default settings are adequate and appropriate.
Click ‘Next’ to set the spacing between legend elements:

![Legend Wizard](image)

Usually, the default settings are fine. If necessary, adjust these values and then click ‘Finish.’

Preview your legend. There will probably be some problems with it:

1. This layer heading doesn’t explain what the layer contains;
2. This heading is meaningless;
3. The layer names displayed here do not explain the meaning of the layers.

Each of these problems is easily rectified.

First, open the Legend Properties window by double-clicking the legend or by right-clicking it and selecting “Properties...”
To remove the legend title: Uncheck the ‘Show’ box under the ‘Title’ textbox.

To display a Map Title in place of the legend title: Ensure the ‘Show’ box is checked, and enter a meaningful, descriptive title in place of the legend title. Note that you can enter line breaks.

To reorder legend items: In the ‘Items’ tab, use the arrows to reorder items.
To remove unnecessary layer headings (Problem ‘2’): Select the problematic layer in the ‘Items’ tab and click ‘Style’, then click ‘Properties’:

In the ‘General’ tab, uncheck ‘Show Heading’, then click ‘OK’ twice to return to the Legend Properties window:

To change font settings for all labels: In the ‘Items’ tab of the Legend Properties window, use the dropdown box to select ‘Apply to the label’, and then click ‘Symbol.’ Change the font properties as desired, then click ‘OK.’

To rename legend items (Problems ‘1’ and ‘3’): Exit the Legend Properties window. In the Table of Contents, rename the problematic layer(s) one at a time by selecting it, clicking once, editing the text, and pressing ‘Enter’. The text in the legend will update automatically.
At this point, your legend should be complete:

![Map Legend](image)

### Add a North Arrow

Navigate to the ‘Insert’ menu and clicking ‘North Arrow...’
Select an arrow from the North Arrow Selector window, and click ‘OK’. Move and/or resize the new north arrow as appropriate.

![North Arrow Selector](image)
**Add a Scale Bar**

Navigate to the ‘Insert’ menu and clicking ‘Scale Bar...’ Choose a scale bar style, and click ‘OK.’

You may need to alter the settings for the scale bar. For instance, the scale bar below displays units in Decimal Degrees, a distance measurement which most people don’t understand:

0 0.030 0.06 0.12 0.18 0.24 0.30 0.36 0.42 0.48 0.54 0.60

Decimal Degrees

Open the Scale Bar Properties window by double-clicking the scale bar or by right-clicking it and selecting ‘Properties...’

If necessary, change the Division Units:
Click ‘Apply’ to see the changes:

You may now wish to change the value of divisions – in the example above, it may be more appropriate to display divisions of 10km rather than 8km.

Change the ‘When Resizing...’ dropdown box to ‘Adjust number of divisions.’ Then, change the ‘Division Value’ to the desired value:

![Alternating Scale Bar Properties dialog box]

Click ‘OK’, then move and/or resize the scale bar as appropriate.
The Finished Product: Arranging Map Elements on the Page

After adding a north arrow, legend, scale, and title to your map page, you’ll need to arrange them in order to produce an attractive final product.

In most cases, there are no cartographic conventions in terms of where on the page these map elements are placed. That said, many maps employ an all-in-one information box which contains all of the map elements; this box can be placed atop the map such that it doesn’t cover up any important features. Below is an example of such a box:

![Map Example]

To arrange your elements into a box such as the one above, you’ll need to know how to align and distribute elements, how to group and ungroup elements, and how to add ‘Neatline’ borders and backgrounds to elements.

**Aligning Elements**

There are two types of alignment: you can align (an) element(s) to the margins of your page, or you can align two or more elements with each-other.

To align an element to a margin, use the *Select Elements* arrow to select the necessary element. Right-click it, and navigate to the ‘Align’ submenu, and ensure ‘Align to Margins’ is selected (pictured at right).

Next, with the element still selected, right-click again, navigate to the ‘Align’ submenu again, and use one of the options to align the element to the margins.
To align two or more elements with each other, use the shift-key and the **Select Elements** arrow (↑) to select the elements you want to align. Select them in such an order that the element you want to align to is the last one you select (that is, if I want my legend to align to the left edge of my title, I would first select my legend and then select my title).

Right-click one of the selected elements, navigate to the ‘Align’ submenu, and ensure ‘Align to Margins’ is not selected. Then, right-click again, navigate to the ‘Align’ submenu, and use one of the options to align the selected elements to the last selected element:

**Distributing Elements**

Distributing elements automatically positions them such that they are equally spaced from one another:
To distribute items which are in a vertical column, place the upper- and lower-most elements into position, and then select them, along with all elements between them. Right-click on one selected element, navigate to the ‘Distribute’ submenu, and click ‘Distribute Vertically.’

To distribute items which are in a horizontal line, place the left- and right-most elements into position, and then select them, along with all the elements between them. Right-click on one selected element, navigate to the ‘Distribute’ submenu, and click ‘Distribute Horizontally.’

**Grouping and Ungrouping Elements**

You may wish to group several selected elements together so ArcMap treats them as a single element – you may need to do so to properly align the group, for instance. To group elements, simply select all the elements which will participate in the group, right-click on one of the selected elements, and click ‘Group.’ To ungroup a group, select the group, right-click it, and click ‘Ungroup.’

**Adding a Border and Background to Selected Elements**

To make your all-in-one information box legible, you’ll probably need to add a background to it. First, arrange all of the elements into a rectangle, such as the one shown below:

Now, group all of the elements together:
Now, ensure the group of elements is still selected. Open the ‘Insert’ menu and click ‘Neatline...’:

In the *Neatline* dialogue box, ensure ‘Place around selected element(s)’ is selected. Next, check the ‘Create separate neatline element’ box and also check the ‘Group neatline with element(s)’ box.

Enter a suitable ‘Gap’ value – this value determines how much white space will be left between the elements and the border. Generally, a value between 5 and 10 pts is appropriate.

Now, use the dropdown box under ‘Border’ to select an appropriate border (*Note: The border around the legend/information box should never be wider than the border around the map itself, if one exists. Usually, a simple line border of 0.5pts – 1pt is appropriate*).

Finally, use the dropdown box under ‘Background’ to select an appropriate background colour. In almost every case, the background colour should be white.

Do not apply any rounding and do not apply a drop shadow: these tend to look tacky on most maps.
Click ‘OK’ to apply your neatline.
And there’s your finished ‘Information Box’!

At this point, if you need to change anything within the box, you’ll need to ungroup the neatline from the elements within. Just select the box, right-click it, and click ‘Ungroup’.

**Placing the Information Box on the Page**

Take a look at your map page. In most cases, there will be a corner or an edge of your map which doesn’t show anything important.

In the example at the right, the top-right corner doesn’t contain any information pertinent to the Uptown Waterloo BIA. I actually made this happen on purpose — I panned my map slightly to the northeast so that I would have enough room to place my legend.

Find a spot on your map where you might put your information box. If you need to, zoom out or pan around a bit until you have enough room.

Again, there is no rule as to where this information box should go.

When placing your box, don’t forget to align it to the edges of your map!
The finished product
11. Save, Export, and/or Print Your Map

Once your map is complete, save the map document for future use by clicking the ‘Save’ button ( ).

When prompted, enter a suitable name and location for the map document.

Exporting Maps for Print or Web Use

You can export completed map layouts to any of 10 file formats:

- JPEG, TIFF, GIF, BMP, and PNG raster image formats for use on web pages, for embedding in Microsoft Word documents, etc.

- EMF, EPS, SVG, AI, and PDF vector image formats for use in publishing, for further editing in graphics software, etc.

The choice of export format depends on your needs. If you intend to embed your map in a Word document, use PNG or JPEG. If you need a high-quality map for publication, or if you intend to edit the map in a graphics package, use PDF or AI.

See http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?id=450&pid=447&topicname=Exporting_a_map for a description of each of the file formats (Scroll down to ‘Supported File Formats’).

To export your map layout, open the ‘File’ menu and click ‘Export Map...’:
In the Export Map dialogue box, follow the numbered steps below:

1. Browse to the folder in which the exported map will be saved.
2. Enter a suitable name for the map. Don’t worry about the extension.
3. Choose an export file format from the drop-down box.
4. Set advanced options specific to the chosen file format.

See [http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?id=450&pid=447&topicname=Exporting_a_map](http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?id=450&pid=447&topicname=Exporting_a_map) for more information regarding advanced options for each file format (Scroll down to ‘How to Export a Map’ and then locate your chosen file format).

**Printing Your Map**

Do not use ArcMap’s print features – the resulting print can be unpredictable in quality.

Instead, export your map to a PDF at 300 (or higher) DPI, and then print the PDF. This will save time and will ensure a high-quality print every time.
Creating Maps in ArcMap: A Quick Guide

Exporting your Map to KML for use in Google Maps or Google Earth

You may wish to export your map, or parts thereof, to KML or KMZ, which you could then open using Google Maps or Google Earth:

(The image above is an example of some landmark, trail, hydro, and park data from the City of Kitchener displayed in Google Maps).

For a complete guide to exporting your map to KML or KMZ, please refer to the University Map Library’s tutorial ‘Google Earth : Level II’, available from http://www.lib.uwaterloo.ca/locations/umd/digital/tutorials.html
Appendix A: Projecting Your Data

Occasionally, when combining data from different sources, you may run into problems with projections or coordinate systems. Your data may not match up, you may receive an error message, or your map may just look plain wrong (The example below is a world map projected using NAD 83 UTM Zone 17N).

Before being able to tackle problems with projections and coordinate systems, you need to understand what these terms mean. Below are some excerpts from ArcGIS Desktop Help:

The features on a map reference the actual locations of the objects they represent in the real world. The positions of objects on the earth’s spherical surface are measured in geographic coordinates. While latitude and longitude can locate exact positions on the surface of the earth, they are not uniform units of measure; only along the equator does the distance represented by one degree of longitude approximate the distance represented by one degree of latitude. To overcome measurement difficulties, data is often transformed from three-dimensional geographic coordinates to two-dimensional projected coordinates.

Because the earth is round and maps are flat, getting information from a curved surface to a flat one involves a mathematical formula called a map projection, or simply a projection.

This process of flattening the earth will cause distortions in one or more of the following spatial properties:
If your spatial data references locations with latitude and longitude—for example, decimal degrees—you can still display it on your map. ArcMap draws the data by simply treating the latitude-longitude coordinates as planar x,y coordinates. If your map doesn't require a high level of locational accuracy—you won't be performing queries based on location and distance, or you just want to make a quick map—you might decide not to transform your data to a projected coordinate system. If, however, you need to make precise measurements on your map, you should choose a projected coordinate system.

**Geographic Coordinate System (GCS).**
Regardless of which GCS you use, the world is presented as a rectangle: 360 Degrees of longitude (X Coordinate); 180 Degrees of latitude (Y Coordinate). The width and height of the rectangle may differ between GCSs.

**Projected Coordinate System (Robinson)**
To avoid headaches later on, try following the guidelines below when making maps. Note that these are simply recommendations: there is no “best” projection to use.

**If you’re making a map in Waterloo Region or its immediate surroundings...**

Use the NAD 1983 UTM Zone 17 projected coordinate system.

**If you’re making a map of other cities or small areas in the world...**

Use the appropriate NAD 1983 UTM Zone for your projected coordinate system. Use the map at: 

Note: DO NOT use a UTM projection if your map will be wider than the zone you are using – doing so will cause significant distortion around the edges of your map.

**If you’re making a map of Canada as a whole...**

Use the NAD 1983 geographic coordinate system or the NAD 1983 Statistics Canada Lambert projected coordinate system.

**If you’re making a map of the United States as a whole...**

Use the USA Contiguous Albers Equal Area Conic projected coordinate system.

**If you’re making a map of the whole world...**

Use the WGS 1984 geographic coordinate system or an appropriate projected coordinate system (the Robinson projected coordinate system is widely used for world maps).

To change the coordinate system of your map, open the Data Frame Properties by double-clicking on the data frame title in the Table of Contents or by right-clicking the title and clicking ‘Properties...’:
Switch to the ‘Coordinate System’ tab:

![Image of Data Frame Properties dialog box with Coordinate System tab selected]

Browse to the chosen Coordinate System (See a list of commonly-used paths below):

![Image of Data Frame Properties dialog box with Coordinate System tab selected, showing available coordinate systems]

Double-click the chosen Coordinate System, then click ‘Apply.’

You may receive a warning (reproduced on the following page). If this warning pops up, click ‘Yes’:
IF YOU RECEIVE THE WARNING ABOVE, return to the Data Frame Properties Window / Coordinate System tab and click ‘Transformations.’

For each GCS listed in the ‘Convert From’ box, select it, then choose the first value in the ‘Using’ dropdown box.

Click ‘OK’, and ‘OK’ again to return to your map.

IF YOU DID NOT RECEIVE A WARNING, click ‘OK’ to return to your map.
**Paths to Commonly Used Coordinate Systems**

(All paths begin from the ‘Predefined’ subfolder)

- NAD 1983 Geographic Coordinate System:
  Geographic Coordinate Systems -> North America -> North American Datum 1983

- NAD 1983 UTM Zones:
  Projected Coordinate Systems -> UTM -> NAD 1983 -> (Select the correct zone)

- NAD 1983 Statistics Canada Lambert:
  Projected Coordinate Systems -> National Grids -> Canada

- USA Contiguous Albers Equal Area Conic:
  Projected Coordinate Systems -> Continental -> North America

- WGS 1984 Geographic Coordinate System:
  Geographic Coordinate Systems -> World -> WGS 1984

- Projections for World Maps:
  Projected Coordinate Systems -> World -> (Experiment with different systems)